CHAPTER 4
CARDINAL EXCEL MODEL REFERENCE

TABLE OF CONTENTS
Introduction 2
Cardinal Model Overview 4
   EntryInputs Sheet Tab 6
   Accounts Sheet Tab 7
   BSE Sheet Tab 8
   Focus on Event Button 9
   T-Account Button 12
   BS Sheet Tab 14
   Account Selection Button 18
   BS, IS, DCF, SCF Sheet Tabs 20
   Cash Management Sheet Tab 21
   UserAnalyses Sheet Tab 21
   Navigating Cardinal 21
Excel Basics 22
   Overview 22
   Magnifying Worksheets 25
INTRODUCTION

This describes Cardinal, a start-up retail merchandising company that has financial statements similar to Gap, Inc. The Cardinal Excel model will help you understand some key business and accounting decisions as well as entries behind retailers’ financial statements.

Our fictitious story begins near the end of the current year (year 0) when Carolyn Carter plans to start Cardinal as a retail merchandising company. She expects to open its doors to customers shortly thereafter on January 1, year 1. In the mean time, Cardinal must incorporate, attract financing at favorable terms, lease stores, outfit them with fixtures etc., purchase merchandise, hire employees, arrange for advertising and other marketing initiatives, and take other steps needed to get ready to serve its customers.

To attract financing from venture capitalists and banks at favorable terms, Carolyn Carter must convince these investors that Cardinal will provide them an adequate return on their investments. To this end, she will create a business plan that will include several elements including a financial plan. Her financial plan includes an Excel financial model for Cardinal that is based on several flexible assumptions about its future prospects.

Each of the assumptions can be changed easily within the Excel model to assess the consequences of new assumptions on Cardinal’s projected financial results. Thus, the assumptions are the model’s inputs and the financial projections its outputs.

Carolyn Carter, her staff, and prospective investors will spend considerable time scrutinizing these assumptions and their financial consequences before committing resources to Cardinal.

The Cardinal model is a pro-forma financial model. Similar models are used frequently by start-up companies and by financial analysts on Wall Street. Pro forma financial statements differ in one of two ways from the official statements companies are legally required to report to the public:

1. Pro forma statements can report estimates of future financial measures, which is what the Cardinal model does. These “forward looking” pro forma statements are used in conjunction with budgeting, strategic planning, valuing projects or companies, and other planning activities.

2. Pro forma statements can report current and past financial numbers taken from the official statements, but presented in a different format. For example, recently many companies have started releasing pro forma financial statements during meetings with analysts. These often omit income components that many analysts believe are measured unreliably and thus distort the official income measure reported in actual statements.
In the earlier exercises, you recorded entries into a balance-sheet-equation matrix and checked your answers in PowerPoint slides or the solutions at the end of the chapter.

You can check your record keeping entries for Cardinal using the Excel model and you can determine how entries affect the balance sheet, income statement, and the cash-flow statement. In addition, you can easily identify the entries that affect an account, which is an essential skill for reverse engineering these entries.

Prior to using the model, students often have the misconception that they will record entries into the models. Instead, you record entries manually on paper and check your answers against entries recorded in the Cardinal Excel model.

To record Cardinal entries, you will use Cardinal’s chart of accounts and descriptions of its entries. There is a hard copy of this in the course packet for this session. Then check your answers in the Cardinal model as described herein.

If you are reading a hard copy of this chapter, you should consider viewing the following figures in color by opening the Acrobat version, which is in the Chapter 4 folder in the Navigating Accounting CD (Chapter_04.pdf).

If you copy the Cardinal Excel Files folder to your computer's hard drive, be sure to copy all files and maintain the sub-folder structure. In particular, all of the contents in the Cardinal folder, including its sub-folders, must be copied for the hyperlinks in the Cardinal model to work.

**Caveat:** Navigating Accounting's files have only been tested on Microsoft Windows platforms using Microsoft Office. In particular, they have not been developed for, nor tested on, Apple machines and they have features that may not work on Macs.
CARDINAL MODEL OVERVIEW

The following describes the basic functionality of the Cardinal model. In particular, it will help you check your answers in the model and trace the consequences to Cardinal’s financial statements.

- If you do not already have Excel installed on your computer, purchase and install it before continuing.
- You must weaken the security settings in Excel before you open the Cardinal file (since it contains macros). See the Microsoft Tips folder in the Navigating Accounting CD for more instructions.

Open the Cardinal model Excel file:

Double click on Navigating Accounting CD> Excel Files > Cardinal > Cardinal8.xls.

Click Enable Macros.

A screen similar to the one below appears.

Clicking the highlighted “START HERE” button launches a movie that describes the home page illustrated above. Other movies on the home page describe how to use the model and how it relates to Cardinal’s business.
The Cardinal model has several sheets arranged in the order information flows through the model (see the tabs at the bottom of the model):

- **Start Sheet**: This worksheet provides a user-friendly interface for setting select assumptions. Excel functions called *macros* transfer information entered into the Start sheet to the Assumptions sheet. However, the Start sheet does not contain all of the assumptions. Some of them can only be set in the Assumptions sheet.

- **Assumptions Sheet**: All of the model’s inputs are located in the Assumptions sheet.

- **Computations Sheet**: Based on assumptions from the Assumptions sheet, numerous financial measures are computed in the Computations sheet. For example, market share is computed based on assumptions about brand investments, pricing policies, and other factors that affect market share. Sales are then computed based on the market share computations and the market size assumptions.

- **EntryInputs Sheet**: The EntryInputs sheet arranges data computed in the Computations sheet in a way that facilitates recording entries. Note that data flows from the Computations sheet to the EntryInputs sheet.

- **Accts Sheet**: Entries are recorded into accounts, which are essentially places where financial measures are accumulated. The Accts sheet contains the names of Cardinal’s accounts.

- **BSE Sheet**: Based on information in the EntryInputs and Accts sheets, the model records entries into the balance-sheet-equation sheet (BSE). Note that data flows from EntryInputs and Accts into BSE and that BSE stores data in a form that can be accessed easily to create financial statements.

- **BS, IS, SCF, DCFO Sheets**: These sheets report the balance sheets (BS), income statements (IS), statement of cash flows with indirect operating sections (SCF), and direct cash flows from operations (DCFO) for years 0-17. After year 17, the model assumes that Cardinal reaches a steady state, which means that it reaches a point where the subsequent cash flows repeat themselves. This assumption will make sense after you have taken a finance course.

- **Cash Management Sheet**: This sheet reports much more detailed operating cash flows than the DCFO sheet and an analysis of Cardinal’s cash surpluses and shortfalls. Unlike the other financial statements in the model, this sheet represents the type of information a management team and the treasury department would need to manage cash flows. This sheet provides you an insider’s perspective into cash flows.
• **UserAnalyses Sheet**: As its name suggests, the UserAnalyses sheet contains measures often created by users from information in financial statements and elsewhere. It reports the present value of Cardinal's common stock or valuation of the company, given the current assumptions, common size income statements and balance sheets, the Dupont model, and several other common ratios.

Next we will walk through screen shots from the Cardinal model. You may want to open the Excel model and follow along.

*Open the Cardinal Excel file by double clicking on Cardinal8.xls:*

*Navigating Accounting CD > Excel Files > Cardinal > Cardinal8.xls*

The exhibit below appears on your screen.

**ENTRYINPUTS SHEET TAB**

*To go to the EntryInputs sheet, which contains brief descriptions of the entries, click the EntryInputs tab.*

The screen on the next page appears.
As indicated below, there are two ways to learn about entries:

1. The relatively large cells in the center of the EntryInputs sheet describe the entries qualitatively in adequate enough detail so that an expert could record the entry.

   The numbers in the adjacent cells to the right provide related quantitative data that depends on assumptions (made in the Assumptions sheet) and computations (in the Computations sheet).

2. The “More Details” buttons to the left link the Excel model to PowerPoint slide shows that illustrate the entries, define new terms, and sometimes provide other information you might find useful. These buttons only work if the related PowerPoint files (Car0.01.ppt, Car0.02.ppt, etc.) are in the Cardinal folder along with Cardinal8.xls. At this time, only the first 7 of the more details buttons work. Still, these should help you learn how to address the record keeping steps to determine what happened.

   The entry codes on the far left are interpreted as follows: The number before the decimal is the year the entry is recorded and the number after the decimal orders the entries for that year. For example, Car0.10 is the 10th entry recorded in year 0, the start-up year.

   The entry codes on the far left are interpreted as follows: The number before the decimal is the year the entry is recorded and the number after the decimal orders the entries for that year. For example, Car0.10 is the 10th entry recorded in year 0, the start-up year.

ACCOUNTS SHEET TAB

To record entries, you will also need Cardinal’s chart of accounts. Scroll to and click the Acts tab, which is immediately to the right of the EntryInputs tab.

The figure on the next page appears.
The Accts sheet lists Cardinal’s accounts, grouped into primary balance sheet classifications (assets, liabilities, and owners’ equities). The owners’ equities are further classified as permanent or temporary.

When recording Cardinal entries, you will likely get information to record entries from hard copies of the Accts and EntryInputs sheet. This will permit you to stay in the BSE sheet discussed next, which is where the solutions can easily be accessed.

**BSE Sheet Tab**

Select the BSE sheet by clicking the tab immediately to the right of the Accts tab.

The screen on the next page appears.
Set the magnification in the zoom box to 50%.

The BSE sheet is a large balance-sheet-equation matrix.

Cardinal’s balance-sheet-equation matrix is much larger than ABC’s but the same concepts apply. ABC’s matrix has 14 rows and 13 columns or 182 cells. By contrast, Cardinal’s matrix for year 0 and year 1 combined has 39 rows and 25 columns or 975 cells.

The exhibit above illustrates that the rows of the matrix are Cardinal’s entries and the columns its accounts.

Cardinal’s first entry (Car0.01) records a stock issuance. Cardinal receives $1 from its founder, Carolyn Carter, and issues her shares of non-par stock.

You can see the $1 increase in cash in the matrix: $1 is recorded in the first row immediately below C for cash. To see the $1 increase in PIC (paid-in capital), you could scroll to the right until you located the appropriate column. But, there is a better way.

**FOCUS ON EVENT BUTTON**

*Click the Focus on Event button* (the second button above the list of entries). The screen on the next page appears.
Clicking the Focus on Event button opens the Focus on Event pop-up window.

Let’s focus on Car0.03, purchase inventory on account, to see how it is recorded:

1. Select the entry in the pop-up window: Use the scroll bar on the right to scroll to the entry and then click on Car0.03. This will highlight the entry as indicated below.

2. Click the Focus button on the right side of the pop-up window.

The screen on the next page appears.
Clicking Focus hides all of the rows and columns in the balance-sheet-equation matrix except those related to the focused entry, Car0.03.

Thus, focusing on an entry reveals the entry’s mini equation. This allows you to quickly determine how an entry is recorded after you try to record it on your own.

To view the entire mini equation, select the area that contains the entry and then choose Selection in the Zoom box. You will see the cells in the exhibit below.

Focusing color-codes the entry’s numbers so that you can trace them to journal entries, T-Accounts (discussed shortly), and the financial statements. The colors have no inherent meaning. For example, green always pertains to the first account in the equation, blue to the second, etc.

**Journal Entry Button**

Focusing also reveals the Journal Entry button, which is immediately below the entry’s description.

*Click the Journal Entry button.*

The screen on the next page appears.
Clicking the Journal Entry button reveals a color-coded journal entry. This coding will help you understand how the two record-keeping models described in this chapter relate to each other.

In particular, the color coding provides a convenient way to practice the rules for converting balance-sheet-equation entries to journal entries discussed earlier in this chapter.

**T-Account Button**

To view the T-Account for a specific account, click the T-Account button immediately above the account’s abbreviation in the balance-sheet equation.

*Click the T-Account button for Merchandise inventories, MerInv.*

The screen on the next page appears.
Clicking the T-Account button for MerInv reveals a color coded T-Account. T-Accounts are the debits-credits-model analogue of columns in the BSE matrix.

**T-Account Conventions**

- Debit (credit) account’s beginning and ending balances are on the left (right) side of the account.
- Debit (credit) accounts record increases associated with entries on the left (right) side of the account.
- Debit (credit) accounts record decreases associated with entries on the right (left) side of the account.

**Hiding T-Accounts and Journal Entries**

The T-Account and Journal Entry buttons are toggle switches that cause the related content to be visible or hidden.

*Click the MerInv T-Account button and Journal Entry button to hide these items.* The screen on the next page appears.
Click the BS button to see how an entry affects the balance sheet. Alternatively, click the BS tab.

The Cardinal Excel model uses color coding to help you assess entries’ financial statement consequences.

BS Sheet Tab

To see how Car0.03 affects Cardinal’s balance sheet, click the BS button that is immediately to the right of the Focus on Event button or the BS tab at the bottom.

The screen on the next page appears.
Notice that Merchandise Inventories and Accounts payable are highlighted in the same colors that they were coded in the balance-sheet-equation entry. This gives you the visual indication of where the entry affected the statement.

To return to the BSE sheet, you can click the BSE tab, or click the record keeping and reporting icon in the upper left corner.

*Click the icon and the screen on the next page appears.*
You can view how Car0.03 affects the other financial statements by clicking the buttons to the right of the Focus on Event button.

Alternatively, you can use the sheet tabs on the bottom (IS, SCF, DCFO) to go directly to the statement.

Don’t be alarmed if you click on another statement and don’t see any color-coding. Not all entries affect all statements!

To view another entry, click Focus on Event and select another event from the pop up menu and repeat the earlier steps.
To exit the focused state and thus return the model to its initial state, select **Focus on Event** and then select **No Focus** in the pop-up window.

The screen on the next page appears.
ACCOUNT SELECTION BUTTON

The Cardinal Excel model has a feature that will help you identify the entries that affect accounts.

To view the entries that affect an account, click the Account Selection button, which is immediately below the Focus on Event button.

Click **Account Selection** and the pop up menu in the next panel appears.
To view the entries that affect an account, select it from the list in the pop up menu and click the Select button on the right side of the pop up menu.

Select the **accounts receivable (gross)** account from the list and click Select.

The screen on the next page appears.
Depending on the size of your screen, sometimes you will have to use the scroll bars to see the selected account.

For the example, we see that no entries affect accounts receivable during year 0. The beginning and ending balances are zero and no entries are recorded during the year. There are no accounts receivable year-0 entries because Cardinal does not start selling goods to customers until year 1.

For year 1, we see that Cardinal records $563,643 of sales on account (Car1.02) and $558,006 of customer collections (Car1.04). You can confirm that these are the only year 1 entries by scrolling down through the other entries.

You can also confirm that the ending balance is $5,636, the difference between the year-1 billings and collections.

To view the entire BSE sheet when you have finished studying accounts, click **Account Selection button**, select **SHOW ALL ACCTS** from the list and click Select.

**BS, IS, DCF, SCF Sheet Tabs**

You can use the sheet tabs on the bottom to go directly to a statement: BS—balance sheet, IS—income statement, SCF—statement of cash flows, and DCFO—direct cash flows from operating activities.
Cash Management Sheet Tab
This sheet reports much more detailed operating cash flows than the DCFO sheet and an analysis of Cardinal’s cash surpluses and shortfalls. Unlike the other financial statements in the model, this sheet represents the type of information a management team and the treasury department would need to manage cash flows. This sheet provides you an insider’s perspective into cash flows.

UserAnalyses Sheet Tab
As its name suggests, the UserAnalyses sheet contains measures often created by users from information in financial statements and elsewhere. It reports the present value of Cardinal’s common stock or valuation of the company, given the current assumptions, common size income statements and balance sheets, the Dupont model, and several other common ratios.

Navigating Cardinal
Throughout the Cardinal model, there are navigation icons such as the one for the conceptual framework. These icons serve two purposes. First, they facilitate navigation: clicking on them takes you to specific areas of the Cardinal workbook. Second, they reinforce connections between Navigating Accounting’s conceptual and applications frameworks.
EXCEL BASICS

This section uses the Cardinal Excel file to introduce basic features that you need to understand to complete *Navigating Accounting* exercises. Excel is a powerful program that has many tools that can be used to solve computational problems. For now, you simply need to know how to open Excel files, navigate through them, click a few buttons, and enter values.

**OVERVIEW**

To learn the basics, you need to first understand the way Excel structures data — its data-structure hierarchy:

- **Workbooks**: These are the largest data structures in the Excel hierarchy. When you open the Cardinal file, you are opening an Excel workbook. Thus, the storage unit that contains all of Cardinal's numbers and graphics is called the Cardinal workbook.

- **Sheets**: Sheets, also called worksheets, are workbook substructures that can contain many types of data including among other things numbers, formulas, text, and graphics.

- **Cells**: Worksheets are comprised of numerous cells, which are the smallest storage unit in the Excel hierarchy. A worksheet's cells are arranged in a table that has rows and columns. The columns are designated by letters. The first column is “A”, the second “B,” the twenty seventh “AA” and so on. The rows are designated by numbers, starting with 1. Cells have default names that can be changed. The default name for the cell in the first column and first row is “A1.”

If you are reading a black and white paper hardcopy of this, you can view the screens that follow in color by opening the Adobe PDF file, which is the Read Me file in the *Navigating Accounting* CD (Read_Me.pdf).

- If you do not already have Excel installed on your computer, purchase and install it before continuing.
- You must weaken the security settings in Excel before opening the Cardinal file (since it contains macros). See the Microsoft Tips folder in the *Navigating Accounting* CD for more instructions.

*Open the Cardinal Excel file by double clicking on:*

*Navigating Accounting* CD> Excel Files > Cardinal > Cardinal8.xls

The “8” near the end of the file name is the version as of this writing. You may have a later version, which will have a higher number.
When Cardinal opens, a window similar to the one below appears.

![Microsoft Excel window](image)

Macros may contain viruses. It is always safe to disable macros, but if the macros are legitimate, you might lose some functionality.

Click **Enable Macros**. A screen similar to the following appears.

![Excel features](image)

The above screen illustrates features of Excel files that you will use frequently. The file name, menus, tool bar, and scroll bars are similar to their counterparts in Adobe, PowerPoint, and other software that runs in Microsoft Windows. Several features are highlighted:

- The **name box** is located below the tool bar and to the left. It indicates the name of a selected cell or region in the worksheet. Cell L30 is selected in the screen above.
The **formula bar** contains formulas, text, or numbers in the selected cell. The formula bar is empty in the exhibit because there is no data in the selected cell.

The **selected worksheet** is the large region below the formula bar. When you open Cardinal, the START sheet is selected.

The **sheet tabs** located near the bottom of the window (in the tabs bar) allow you to easily navigate from sheet to sheet. The START sheet is highlighted in the exhibit to indicate that it is the selected sheet. To select a sheet, you simply click its tab.

The **tab scroll buttons** located to the left of the sheet tabs allow you to see hidden tabs. The first scroll button from the left exposes the first tab and as many to its right as will fit in the tab bar. Clicking the second button exposes the first hidden tab at the left end of the tab bar (if one is hidden). Clicking the third button exposes the first hidden tab at the right end of the tab bar. Clicking the fourth button exposes the last tab and as many to its left as will fit in the screen.

Click the fourth tab scroll button to expose the last sheets in the workbook. Click the SCF tab and a screen similar to the following appears.
**Magnifying Worksheets**

There are three ways to magnify worksheets.

1. Select the Zoom option at the View menu, as illustrated on the previous page. At the pop-up window that appears, select a pre-specified magnification, customize the magnification, or magnify a selected worksheet region (as illustrated shortly).

2. Click and hold the small arrow to the right of the **Zoom box** on the toolbar, as illustrated on the previous page. Drag the mouse to one of the options and release it to execute the option. If the Zoom box is not on the tool bar, you can place it there:
   - From the Tools menu, select Customize
   - Select the Commands tab near the top of the pop-up window that appears
   - Select View from the categories on the left-most list
   - Scroll through the icons in the icon list on the right until you find the Zoom box.
   - Click and drag the Zoom box icon to the tool bar.
   - Spend a few minutes studying the other buttons (icons) you can add to the tool bar before closing the Customize window (click the X in the upper right corner of the Tools menu when done).
   - You can remove buttons from the tool bar (while at the Customize window) by clicking and dragging them off the Tool bar.

3. Click **Zoom-In** or **Zoom-Out**, providing these icons are on the tool bar. Each click increases or decreases the content window by a prespecified increment.

*Use one of above methods to change the magnification to 50%.*

A screen similar to the one on the next page appears. Notice that more data is in the window but that is difficult to read.

The screen on the next page illustrates how to select worksheet regions, which is a required preliminary step to perform functions on regions. You will select a region in Cardinal's cash flow statement as indicated on the next page so that you can magnify it to a size that you can see more clearly.
As indicated above, to select the operating section of Cardinal's statement of cash flows for years 0 and 1:

**Click cell C1 and drag the mouse to cell H82.**

By starting with cell C1, you are selecting a region that includes the years at the top of worksheet. Cell H82 contains cash from operations for year 1 and thus it should be in the bottom right corner of the selected region.

Once you have selected a region, you can magnify it in two ways:

1. Use the View menu: Select the Zoom option at the View menu, click the Fit selection button at the pop-up window that appears, and then click OK.

2. Use the Zoom box on the tool bar: Click the small arrow to the right of the box, drag down the list until you reach Selection, and then release the mouse.

*Use one of the above options.*

A screen similar to the second one on the next page appears.
Notice in the bottom screen on the previous page that the selected text now fills the complete width of the window. The only way to magnify this selection more is to expand the size of the Excel window, providing there is room to do so on the computer screen, and then repeat the steps you just followed (select the region and then select Fit region).